EXPORT DATA FROM DAISEY

1. Navigate to https://daisey.cete.us/kehs/login, log in, and accept the terms of the

security agreement (you will have to do this each time you log in).

2. From the homepage, choose Data Management listed in the menu:

\'Z
>< DAISEY

—L___ connecting the first five years to a lifetime of success

A Family Profiles

A e Announcements
Environment Data

Aw DAISEY support email addresses Jan 12, 2016
il Data Management

The DAISEY support team is now using a ticketing system to provide support to DAISEY
— users. With this switch, we ask that you use a new email address for DAISEY support:

it system Management KCCTF DAISEY users should now use daisey.kecti@ku.edu. This includes all ECBG,

CBCAP, and CIF grants.

KEHS DAISEY users should now use daisey.kehs @ku.edu.

3. From the drop-down menu that appears, choose Export, then Export Data.
il Data Management
Import
Export
Export Data

H System Management

4. Find the data you want to export and click Export. (For this specific tutorial you will
want to export mylGDls Literacy+ data).

10 4 records per page Search:
Form ID v Name Category Select One
23 Protective Factors Survey Caregiver Activities ’
22 Add Environment Profile Environment Profile

21 Program Form Child Activities

[E=]


https://daisey.cete.us/kehs/login
https://daisey.cete.us/kehs/login

5. The message below will pop up asking you to specify a date range. This will limit your
export to data collected during the specified time frame. Enter the dates of the
current evaluation year.

Please note: the ECBG evaluation year runs from June 1st to May 31stthe following year.
For example, the 2019-2020 runs from June 1st, 2019 — May 31st, 2020. Therefore, you
would put June 1st, 2019 as the “Start Date”. If you do not specify a date range, all
data that has ever been entered for that measure into DAISEY will be exported.

Alert x

Exports contain sensitive data. Please save exports in a
secure location. To limit the export based on Date of
Activity, select a date range. Leaving the date range blank
will export all data.

Start Date :

End Date :

m Export with Profile

6. Once you specify a date range, click Continue to export the data without the profile
data included or click Export with Profile if you would like profile data as well.

NOTE: While the records are exporting, “In Progress” will appear next to the item. This
normally takes a few moments, and you can navigate to other DAISEY pages to work
while it exports.

23 Protective Factors Survey Caregiver Activities \

22 Add Environment Profile Environment Profile m

7. When the download is ready, “Completed” will appear next to the item. Click on
“Completed” and the export will download as an Excel spreadsheet.

10 4 records per page Search:

Form 1D v Name Category Select One Latest Export

23 Protective Factors Survey Caregiver Activities I Completed

22 Add Environment Profile Environment Profile m



CREATE A PIVOT TABLE TO COUNT NUMBER OF CHILDREN ASSESSED WITH myIGDis LITERACY+

8. Select Rows 1 and 2 by clicking on 1 and dragging to Row 2. They should be
highlighted indicating they are selected.

mylGDI Early Literacy+_data_SAMPLE - Excel

Insert Page Layout Farmulas Data Review View ACROBAT @ Tell me what you want to do...

o X Cut . = = 5 =
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12 Grantee Organization Program 333-10001 02042013
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14 Grantee Organization Pragram 935-10001 0412512013

9. Go to the upper right-hand side of the screen, and click the button that says Delete.

Insert Page Layout Formulas Data i View ACROBAT Q Tell me what you want to do...
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10.Repeat step 8, now selecting Rows 2-5 (“Question Data Type, Question Format Type,
Question Response, and Question Mandatory should all be selected). Again, once
those rows are selected it will be highlighted.

Insert Page Layout Formulas Data View ACROBAT Q Tell me what ¥
= Cut . - | [mm] &
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11.Repeat step 9, and delete the selected rows. Again, this can be done by going to the
upper right area of your Excel sheet and clicking on the Delete button.

Insert Page Layout Formulas Data View ACROBAT Q Tell me what you want to :
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12.After steps 8-11, your Excel sheet should be a replica of the below screenshot. Row 1
should be as follows: Question Label, Grantee, Organization, Program, Child ID, etc.

Home Insert Page Layout Formulas Data Review View ACROBAT Q@ Tell me what
= Cut L . - |
D & Calibri M A A T == - %WrﬁpTﬂ‘t General - I--E %] &
P = Copy C d' I F - Ciil
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- ¥ Format Painter Formatting = Table~ Styles~
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GRAMTEE ORGAMIZATION FROGRAM Child 1D Caregiver ID Diate of Acti
1
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T Grantes Organization Program 333-10001 0dl23!2013
g Grantes Organization Pragram 993-10001 0d/23/2013
3 Grantee Organization Program 935310001 0442512013

13.Select Column E, which should be labeled as Child ID. The entire column should be
highlighted, indicating the entire column is being selected.

Home Insert Page Layout Formulas View ACROBAT Q Tell me what you want to do... Lebrun-Martin, Cassandra 2 Sharg
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14.Click on the tab at the top left side of the spreadsheet labeled Insert.

Formulas View ACROBAT Q Tell me what you want to do... Lebrun-Martin, Cassandra 2 Sharg

— - B — Y | - -
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Clipboard Font P Alignment P Mumber 1 Styles Cells Editing
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Ll E = u} E F G
GRANTEE ORGANIZATION PROGRAM ChildID Caregiver IO Date of Activity
1
2 Grantee Organization Program 533-10001 0204 2013
3 Grantes Organization Program 533-10001 021042013
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5 Grantes Organization Program 533-10001 021042013
E Grantes Organization Pragram §33-10001 02/04/2013
T Grantes COrganizatior Program S33-10001 0412512013
g Grantee COrganization Program 933-10001 0412512013
3 Grantee COrganization Program 933-10001 0412512013
0 Grantee COrganization Program 993-10001 04i2ai203




15.0nce the tab is clicked, a new row of options will appear across your Excel sheet. It
should contain some of the same options as in the screenshot below (depending on
what version or Excel you are currently running).

mylGDI Early Literacy+_data SAMPLE - Excel

Page Layout Formulas Data Review View ACROBAT Q@ Tell me what you want to do... Lebrun-Martin, Cassandra 5

= L - - - - - frany Equation =
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PivotTable Recommended Table  Pictures Online > My Add-ins ~ Recommended i _ PivotChart 3D Line Column Win/ Slicer Timeline Hyperlink ~ Text
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A B C o E F G H
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E| Grantes Organization Pragram 933-10001 020402013
4 Grantee Organization Pragram 933-100001 020042013
El Grantes Organization Program 333-10001 02042013
B Grantes Organization Pragram 933-10001 020402013

16.Click on Pivot Table. It will most likely be the very first option at the very right of these
options under the Insert tab.

mylGDI Early Literacy+_data_SAMPLE - Excel lEal G
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1
z Grantes Organization Program 333-10001 OZi042m3
3 Grantes Organization Program 939-10001 02/0402013
4 Grantee Organization Program 333-10001 021042013
5 Grantee Organization Frogram 933-10001 02/0402013
B Grantes Organization Program 939-10001 02/04:2013

17.A Create Pivot Table box will pop up. It lists some options, but it always defaults to
"Select a table or range." The Table/Range will already be filled out for you.
Click OK on the bottom left of the box.

Create PivotTable ? X

Choose the data that you want to analyze :
@ Select a table or range
Table/Range: | DatalSE:SE 25

ID Use an external data source

Connection name:
Use this workbook's Data Model L

: Choose where you want the PivotTable report to be placed

@ HNew Worksheet -
O Existing Worksheet

: Choose whether you want to analyze multiple tables

1

1

1

1

1

I_

] Location: | -
1

1

1

| DAddthisdatatotheDataModel T
1

1

([ [REILSES R EEC AT} (Rt LR TETIE]



18.Excel has now made you a new Sheet. Your new sheet will have the beginnings of your
PivotTable on it, as pictured below. Locate the PivotTable Fields box on the right-hand
side of your Excel screen. In the top box it should only say Child ID.

Home Insert Page Layout Formulas Data Review  View ACROBAT Design © Tell me.. Lebrun-M.. Q.Share
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A3 ~ S S
A B C D E F G H I 1 - i )
1 PivotTable Fields v X
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2 | !
1
B | PivotTablel search Pl
6 To build a report, choose Child ID
7 | fields from the PivotTable MORE TABLES...
8 Field List
9
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12 =
= T FILTERS Il COLUMNS
13 E 0
14
15 ] —
16 _ -
17 £ ROWS VALUES
18
19
20 -

Sheet! | Data | (@ : 8 Defer Layout Update

19.Mark the box next to Child ID. Select and drag Child ID down into the box that
says Rows. You will notfice your PivotTable on the left-hand side of your Excel sheet has
changed. It should now say Row Labels and have Child IDs listed under that column.

a8 E = u] E F G H | J K L M -

-
— PivotTable Fields o
Row Lab T.I
[933-70001 Choose fields to add to report: g -
335-10002
333-10003
5§33-10004 search P
335-100035
333-10006 | Child ID
33310007
335-10003 MOR BLES...
333-10003
335-10010
333-10011 Drag s between areas below:
333-10012
335-10013
335-10014
[Blank)
Grand Total

-

RS Il COLUMMNS

= ROWS E VALUES
Child ID ~

Sheetl Data | ® P v Defer Layout Update




20.Select Child ID once again, and drag it to the box that says Values. It will change the

name from Child ID fo Count of Child ID in the Values box. Your table on the left should
now have two columns: Row Labels and Count of Child ID. The Row Labels column is
every child by DAISEY ID with data, while the Count of Child ID column is the number of
rows of data submitted for each child.

B C D E F G H | J K [
1 - -
PivotTable Fields NS
IHuu Labels ".ll:ount of Child 1D
333-10001 4 Choose fields to add to report: -
333-10002 14
353-10003 14
Caar
533-10004 14 search P
333-10005 14
353-10006 13 | Child 1D
3533-10007 14
333-10005 14 MORE TABLE
333-10003 14
333-10010 14
999-10011 4 Drag fields betwe as below:
333-10012 10
933-10013 n FILTERS COLUMMNS
333-10014 10
(blank]
Grand Total 174
;1 ROWS = VALUES
2 Child ID hd Count of Child ID -

s}

NOTE: Make sure it says “Count of Child ID” in the Values box and for the title of the second
column in your PivotTable. If it says something other than “Count”, follow the steps below:

In the Values box, click the drop down arrow. Then click Value Field Settings... from
the listed available options.
X Remove Field
5 VALUES 1@ velue Field settings.. |
Sum of Child 1D D Sum of ChildID =+ |

The below Value Field Settings box will pop up. Click the Summarize Values By tab,
select Count from the list, and then click OK.

Value Field Settings ? >

Source Mame: Child ID

Custom Mame: | Count of Child ID

i summarize Values By i Show Values As

Summarize value field by

Choose the type of calculation that you want to use to summarize
data from the selected field

Sum ”
Average

Max

Min

Product A

MNumber Format Cancel



21.At the bottom of your PivotTable is a blue highlighted row that says Grand Total. It is
easy to look at this and assume that (based on the example below) 174 children have
been assess. This is not the case! This is counting the number of rows of data each
child has submitted for them, not the number of children assessed.

A =} C
N
z
B IFqu Labels ".ll:ount of Child ID
4 |[333-10001 14
S | 393-10002 14
E | 393-10003 14
T |993-10004 14
8 |333-10005 14
3 | 993-10008 13
0 |333-10007 14
1 |333-10008 14
2 | 333-10003 14
3 | 333-10010 14
4 | 333-10011 4
5 1 333-10012 10
B | 333-10013 m
T |333-10014 jlu]
8 (k] 1.
3l Grand Total 174 |
0

1
2
3

PivotTable Fields v X
Choose fields to add to report: -
Search o)
| Child ID

MORE TABLES...

Drag fields between areas below:

FILTERS COLUMMNS
ROWS VALUES
Child ID i Count of Child I ~

22.In order to find the actual number of children assessed, we need to count the number
of Child IDs listed under the Row Labels column. In an empty cell below the table type
“=COUNTA" and a box, like the one pictured below, should pop up. Click “COUNTA"
under Functions. (NOTE: If the box does not appear, you will have to type out the full
formula “=COUNTA(" yourself.)

Ii-j'_p'l;-_l:-l'h:-l;ﬁmmqmmpwm—lgww—uu:ul#wlu—*

Row Labels ~| Count of Child 10

333-10001 14
333-10002 19
33310003 14
333-10004 14
933-10005 14
333-10006 13
33310007 14
33310005 14
933-10003 14
333-10070 19
333-1001 d
33310012 1
933-10013 11
333-10014 0
[blank]

Grand Total 174

I =counta |

73 counta

_‘rumher of cells in a range that |

23.0nce selected (or typed out), the box will look like this: “=COUNTA(". It is asking us to

now put in values.




1
2

3 |Row Labels |~ Count of Child ID
d | 333-1000M 1d
5 33310002 14
E | 933-10003 14
T 19339-10004 14
§ | 933-10005 1d
3 33310006 13
10 | 393-10007F 14
11 | 393-10003 14
12 | 333-10003 1d
13 | 333-10010 14
14 | 333-10011 q
18 | 993-10012 10
16 | 333-10013 1
17 | 333-10014 10
18 | [blanlk)

19 | Grand Total 174
20

1 | =COUMT Al

ol
23 COUNTA(valuel, [valueZ], ...) -

24.To get the correct count of children assessed, click on the first Child ID under Row
Labels and drag/select down to the last Child ID listed. Do not include the (blank)
row! Now, after making your selection, press the Enter key on your keyboard.

& E C u] E
f

z

3 IFIDI Labels "'.l:u t of Child ID
4 1355510001 h 14
5 1333-10002 14
6 !933-10003 14
T 1333-10004 14
5 5959-10005 14
3 |933-10006 13
0 333-10007 14
1 1993-1000% 14
Z }999-10003 1
3 1933-10010 14
4 1333-10011 g
5 [993-10012 10
£ 1999-10013 1
7 Ilaaa-mma, 1 10
§ |(blark]

3 | Grand Total 174
0

H |=|:|:|ummm4:m_7!

g COUNTA(valuel, [valueZ], ...)

a

25.The number calculated in the cell indicates the number of children assessed.
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26.1f you want to get an idea of how many children had the required number of
repeated measures, type “=COUNTIF" in an empty cell. A box, like the one pictured

Row Labels

333-100M
333-10002
333-10003
333-10004
333-10005
333-1000E
333-10007
333-10008
333-10003
333-100710
333-100M
333100712
333-10013
333-100714
[blank)

Grand Total

~ | Count of Child 10

14
14
14
1
14
13
14
1
14
14

dq
10
1l
10

14

below, will pop up. Click “COUNTIF” under Functions. (NOTE: Again, if the box does not

appear, you will have to type out the full formula “=COUNTIF(* yourself.)

[ma R D n oy O < T L )

Row Labels

333-10001
333-10002
933-10003
333-10004d
333-10005
333-10006
933-10007
333-10005
333-10003
333-10010
933-10017
333-10012
333-10013
333-10014
[blank]

Grand Total

~ | Count of Child 10

14
14
14
14
14
13
14
14
14
14

4
10
11
10

174

14|_=cn:n.4ntif
®
) COUNTIFS

number of ce

11



27.0nce selected (or typed out), the box will look like this: “=COUNTIF(*“. It is asking us to

now put in values.

00 =1 M N = La M) =

Row Labels

333-10001
333-10002
333-10003
333-10004
333-1000%
333-10006
33310007
333-10008
333-100043
333-100710
333-100M
33310012
933-100713
333-100714
[blank)

Grand Total

~ | Count of Child 10
14
14
14
14
14
13
14
14
14
14

q
0
M
0

174

1| =COUNTIF] |

COUMTIF(range, criteria) _

28.Highlight the numbers under the Count of Child ID column by selecting the first number

and drag down to the last number listed. Again, there is no need to include the
(blank) row in this selection!

0| 00| = | @ | F| || =2 O Q0| Q0 = O QA | Q) P —

Row Labels "'.l:uunt of Child 1D .

333-10001
33310002
333-10003
333-10004
333-10005
33310006
333-10007
333-10008
333-10003
33310070
333-1001

933-10012
333-10013
33310014
[blank]

Grand Total

" —
14
1
18
1d
13
14
18
1d
14
4
0
1l
0

174

14| =COUNTIF(E: E17

COUNTIF(range, criteria)
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29.This is a ‘COUNT IF" option, meaning it will only count certain values if they meet a
specific criterion. We need to add to the formula in the Formula Bar at the top of the
Excel sheet. It should already say “=COUNTIF(B4:B17".

a. In this example, we are using end of year exported mylGDIs Literacy+ data from
DAISEY and wanting a rough count of children who have been assessed with all
subtests of the mylGDls Literacy+ in the fall, winter, and spring.

b. Each individual subtest for a child is entered into DAISEY separately. This means if
a child received all appropriate subtests in the fall (4 subtests), winter (5
subtests), and spring (5 subtests) then they will have at least 14 lines of data
fotal.

c. Therefore, we need to tell the formula to only count children with 14 or more
lines of data. It should say “=COUNTIF(B4:B17, “>=14")". Once that is typed in
the Formula Bar, press Enter on your keyboard.

Insert Page Layout Farmulas Data Review  View  ACROBAT  Q Tellme.. Lebrun-M.. Q_ Share

& > -
EE o -
Clipboard = Font Alignment MNumber Styles Cells Editing E
52 X v f =COUNTIF(B4:B17, ">=14"]| _ w7
A E C u] E F G H | J K L M M 0 (.

Row Labels |~ Count of Child ID

i

| 999-10001 14
i |933-10002 14
i |333-10003 14
! 933-10004 14
i 333-10005 14
i |333-10006 13
1 |333-10007 14
|| 999-10003 14
? |333-10003 14
3 |933-10010 14
1 933-100M 4
3 93310012 10
i |933-10013 1
7 933-10014 10
3 | (blank)

1 |Grand Total 14
0

1 I 14 =CDUNT|F[B4:B1?,">_=14"]
z

NOTE: As previously stated, this example utilizes end of year mylGDiIs Literacy+ data and looks
at children who had the assessment completed for all testing seasons (fall, winter, and
spring). However, if you are looking at exported Literacy+ data after the fall or winter
administration windows, you will need to alter your formula.

e After fall administration, you will enter “=COUNTIF(B4:B17, “>=4")" since there should be
4 lines of data per child after fall administration (4 subtests).

e After winter administration, you will enter *=COUNTIF(B4:B17, “>=9")" since there should
be ? lines of data per child after winter administration (4 subtests in the fall and 5 in the
winter).

e Also note, there may be duplicates in your data, resulting in more lines of data per

child. If this is the case, you will need to complete the next section of instructions to
look into this further.
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30. After you have completed the appropriate formula, you should see a number in the

box with the total number of children which meet the specific criteria you specified in

the formula.

3353-10001
| 93310002
33310003
| 93310004
| 99910005
9 | 393-10006
10 | 333-10007
1 |333-10003
12 1933-100039
13 |933-10010
14 | 333-1001
15 |933-10012
& [333-10013
17 | 933-10014
15 |[blank]

13 | Grand Total

00— o e L Y

'Row Labels |~ | Count of Child ID

14
14
14
14
14
13
14
14
14
14

4
10
11
10

174

21] 14

3l

Formulas for mylGDIs Numeracy data:

(T

This tutorial can also be applied to mylGDIs Numeracy data. The formulas to use in step 29 for

Numeracy data are as follows:

e After fall adminstration, you will enter “=COUNTIF(B4:B17, “>=4")" since there should be

4 lines of data per child after fall administration (4 subtests).

e After winter administration, you will enter “=COUNTIF(B4:B17, “>=8")" since there should
be 8 lines of data per child after winter administration (4 subtests in the fall and 4 in the

winter).

e After spring administration or for end of year data, you will enter *=COUNTIF(B4:B17,
“>=12")" since there should be 12 lines of data per child after spring administration if
they received the assessment at all three points in fime (4 subtests in the fall, 4 in the

winter, and 4 in the spring).

Please feel free to stop here! The following steps will give you a more detailed breakdown of

what subtests (in this example we continue to use mylGDls Literacy+ data: Alliteration,

Picture Naming, Rhyming, Sound Identification, and WODB) by season (fall, winter, or spring)

have been entered into DAISEY for each child.

14



PIVOT TABLE OF SUBTESTS BY SEASON ENTERED FOR EACH CHILD INTO DAISEY

31.Go back to the Data tab. Select Column E (Child ID) through Column M (Testing
Season). To do this, click on Column E at the very top, and select/drag until you get to
Column M. All of the columns selected should be highlighted.

I Home Insert Page Layout Formulas Review View ACROBAT Q Tell me what you want to do... Lebrun-Martin, Cassandra R Share
‘ . =) e .
5 Cut Calibri 1A == B E_(-‘WrapText General - - 4 04 | Em &EX 2 AutaSum AY p
3 Copy - - = & =5 o [T Fin- -
b et Bt B I U- Py . A M E Merge & Center ~ $ v 9 3 [0 00 Conditional Formatas Cell Insert Delete Format e 5.ort& Find &
Formatting~ Tabler Styles~ - v - = Filter ~ Select ~
pboard = Font = Alignment = Number = Styles Cells Editing A
b f« | childID 4
o} E E G H 1 J K L 1 (158
a8 Child ID Caregiver ID Diate of Activity which child was involved? | Sohool of Center Classfinstructar myIGDI Early Literacys Sub | Testing Tupe Testing Season Tier
Assessment Mame
EEea
-10001 02044200 Center eacher Alliteration ‘winter
2044200 Center eacher Fhuming Winter
O2i0420 Center eacher ich One Doesn't Belong “winter
02044200 Center eacher Sound Identification inter
1290201 Center eacher Alliteration pring
(29020 Center eacher Picture [Naming oring
TRETE] Center eacher Rhyming oring
1230201 Center eacher Sound dentification pring
(29020 Center eacher “which One Doesn't Belong oring
1021201 Center eacher Picture Maming
102i201 Center eacher Fhuming Fal
02120 Center eacher “which One Doesn't Belong Fal
021201 Center eacher Sound Identification Fal

32.While the columns are highlighted, click on the Insert tab in the upper left-hand side of
your Excel screen. The following will show up again, and you will want to select the
PivoiTable option.

mylGD| Early Literacy+_data_SAMPLE - Excel =

‘mulas Data Review View ACROBAT Q Tell me what you want to de... Lebrun-Martin, Cassandra

Q- | o = “hl=mt I A —] A 4 - TT Equation -
) El ] P @ s I ™ I=- i 14 2 o == 9
! L 56 T i - LG [ - € symbol
PivotTable @ecommended Table  Pictures Online 3 My Ade-ins ~ Recommended ) PivotChart 3D Line Column Win/ Slicer Timeline Hyperlink  Text Header
PivotTables Pictures @+ Charts L MR A - Map - Loss Box & Footer
Tables Mustrations Add-ins Charts | Tours Sparklines Filters Links Text Symbols
E1 = fx || ChildID
o] E F G H 1 J K L I
PROGRANM Child I0 Caregiver D Diate Of Activity which child was inuolved? | Sehool or Center Classfinstructor myIE0I Early Literacy+ Sub | Testing Tupe Testing Season T
1 Assessment Mame
2 [Program - 020420 Ceenter 2acher Ficture Naming Winter
2 [Program - 02/0420 Center eacher Alliterztion Winter
4 [Program - 02/0420 Center eacher Rhyming Winter
5 | Program - 2i04/20 Center eacher ich One Dioesn't Belong Winker
& | Program - 200420 Center eacher Sound |dentification Winker
7 [Frogram - [T Ceenter eacher Alliteration Spring
& [Frogram - [ERFETED Center eacher Ficture Naming Spring
4 [Program - [ERFETED, Center eacher Fihyming Spring

33.A Create Pivot Table box will pop up. Select OK and your PivotTable will appear on a

new tab.
Create PivotTable ? *

Choose the data that you want to analyze
@ Select a table or range

Table/Range: |DatalSE:SM]| 55

O Use an external data source
Connection name:

Use this workbook's Data Model
Choose where you want the PivotTable report to be placed

@ MNew Worksheet

(") Existing Worksheet
Location: 2]

Choose whether you want to analyze multiple tables

|:| Add this data to the Data Model
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34.For this PivotTable, you may notice the top box includes multiple options now. First,
mark the box next to Child ID. Select and drag Child ID down into the box below Rows.
Your PivotTable on the left should now say Row Labels and have Child IDs listed.

Row Labels -
999-10001 |
999-10002
999-10003
999-10004
999-10005
999-10006
999-10007
999-10008
999-10009
999-10010
999-10011
999-10012
999-10013
999-10014
{blank)

Grand Total

SR E woa o i s W =

ol o
[£%]

PivotTable Fields T

Choose fields to add to report: &

Search 2

| Child 1D > [a
C iver [D

h child was invelved?
ol or Center
/Instructor

dz between areas below:

ERS COLUMMNS

ROWS Z VALUES
Child ID i

35.Now select and drag myIGDI Early Literacy + Sub Assessment Name into the Rows
box. (You may have to scroll down in the top box to find this option.) Literacy+ subtests
should have appeared under each Child ID in your PivotTable on the left.

Row Labels
=999-10001

Alliteration

Picture Naming

Rhyming

Sound ldentification

Which One Doesn't Belong
=1999-10002

Alliteration

Picture Naming

Rhyming

Sound Identification

Which One Doesn't Belong
=1999-10003

Alliteration

Picture Naming

Rhyming

Sound ldentification

Which One Doesn't Belong
=999-10004

Alliteration

Picture Naming

Rhyming

Sound ldentification

Which One Doesn't Belong

=999-10005
Sheet! | Sheet? | Data |

PivotTable Fields R
Choose fields to add to report: -
Search yel

Class/Instructor
+ mylGDI Early Literacy+ Sub Assessmen.. ~

T Tyee
T g Season
MO BLES... -

Dragillds between areas below:

ERS COLUMMS
ROWS E VALUES
Child ID i

mylGDI Early Liter... ¥

Defer Layout Update
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36. Lastly, select and drag Testing Season first under the Rows box, and then again under

the Values box.

Winter

= Picture Naming
Fall
Spring
Winter

= Rhyming
Fall
Spring
Winter

= Sound Identification
Fall
Spring
Winter

= Which One Doesn't Belong
Fall
Spring
Winter

='999-10002

= Alliteration
Spring
Winter

= Picture Naming
Fall
Spring
Winter

- Rhyming
Fall

o W W e W e e e

=
F=

e L I e e e R ]

Loube i mny
Which child was involved?
School or Center
Class/Instructor

+/| mylGDI Early Literacy+ Sub Assessment Na...
Testing Type

| Testing Season

MOR -
Drag jllds b areas below:
ERS COLUMMNS
ROWS ¥ VALUES
Child ID i Count of Testing 5. *

mylGDI Early Liter... ~

Testing Season N

NOTE: Make sure it says “Count of Testing Season” in the Values box and for the title of the
second column in your PivotTable. If it says something other than “Count”, follow the steps in
the NOTE section under step 20 above.

37.In your PivotTable on the left, you can now see which subtests by season each child
has had submitted into DAISEY.

3

4
5
&
7
8
9
0
1
2
%
4

6
7

9

| Row Labels

='999-10001
= Alliteration
Spring
Winter
= Picture Naming
Fall
spring
Winter
- Rhyming
Fall
Spring
Winter
= Sound Identification
Fall
spring
Winter
= Which One Doesn't Belong
Fall
Spring
| Winter
| =999-10002
= Alliteration
Spring
Winter

- |Count of Testing Season
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NOTE: This section of the tutorial can also be applied to mylGDIls Numeracy data.
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